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Striped Windows
4	 Striped fabrics designed by Kaffe Fassett star in this scrappy and colorful 

quilt. Use paper foundations available for download at throughtheneedle.com 
and you’ll be amazed at how easy it is to make a scrappy quilt that sparkles 
like sun through your windows. The complexity lies in bold color combinations 
and the varying block sizes. 

Amazing Glass Etching: Design it with Your BERNINA CutWork Accessory
6	 Use your CutWork Software and Accessory to etch glass! Create the design 

with your CutWork Software, then use some contact vinyl and glass-etching 
cream to etch monogram-style letters onto wine glasses, decorations onto 
vases, and motifs onto high balls and other glassware. 

Jeanine’s Lace Flower 
10	 BERNINA Embroidery Software 6 has so many powerful features! You can 

create your own free-standing lace designs or just jump in and stitch beautiful 
flowers like these in a snap.

Divine Flowers & Vines Ottoman
13	 Displaying beautiful artwork is not limited to wall hangings. Any item with 

a flat surface that can be covered becomes a canvas to display beautiful 
embroidery designs. The Divine Flowers and Vine Premier Collection offers 
elegant dimensional designs for creating breathtaking artwork for any room. 

Upcycled Clothes for Tots
16	 Don’t sell those t-shirts at a yard sale — upcycle them into cute clothes for 

your little ones! It’s easy to recycle t-shirts using your serger! Exposed serger 
stitching ties all of the elements together while creating an additional fashion 
accent. 

Snap Happy Pouches
18	 These Snap Happy Purses are perfect for storing sewing notions, iPod 

chargers, phone accessories, and the like. Create the size you need and the 
style you desire by incorporating stitch recipes, channel 
quilting, or bobbin play embellishments.

The Last Word
22	 Valuable coupons, a list of quick links, and a sneak peek 

inside the next issue of Through the Needle ONLINE.
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It’s June! Soon school vacations will begin — if they haven’t already! — and the long, slow days of summer will be here. 
This issue of Through the Needle ONLINE features projects chosen especially for your summer sewing and crafting.

June is the traditional prime time for weddings, and John Thornton’s etched monogram glasses — created with the 
help of the BERNINA CutWork Software and Accessory — are a quick-to-make gift every bridal couple will appreciate. 
No weddings to attend? They also make a lovely house-warming, anniversary, or “just because I want to” gift. And, 
while you’re planning your outfit for the wedding reception – or other summer soiree – make yourself a pretty flower 
to wear in your hair. Jeanine McWhorter explains her technique for digitizing free-standing lace, and offers a free 
download as a special gift to our readers. 

Every season is the right one for updating your décor, and Liza Lucy’s quilted wall-hanging is a sophisticated play 
on color that will enhance any room. It only looks complicated — foundation-piecing makes it easy to assemble. But 
don’t limit yourself to displaying artwork only on the walls. Debra Rutledge’s ottoman, featuring sculpted satin velvet 
flowers from OESD’s Divine Flowers and Vines collection, is a lovely way to showcase your embroidered creations. 

Summer vacations are perfect times for sharing with friends, their sewing machines, and piles of fabric. Whether 
you’re learning a new technique or brushing up on decorative stitching skills, Paula Harmon’s little pouches are a 
great way to use all those pretty stitched samples. If you have kids who seem to sprout up an inch or two every week 
during the summer, take along a bunch of old knit shirts and follow Nancy Bednar’s example by upcycling them into 
cute toddler outfits. 

How will you spend YOUR summer? We’d love to see your creations! Send photos to  
jo@berninausa.com. Best wishes for a beautiful summer!

P.S. Did you notice our new look? We’re now “publishing” and hosting TTNO on our own 
consumer website! Our web address is still the same: www.throughtheneedle.com, and 
you can also find us using www.berninausa.com/throughtheneedle. 

Jo Leichte 
Editor

Scented Bookmark
Whether you need something to keep your 
place in your latest read, or you want 
to make the gift of a paperback more 
appealing, you’ll need this bookmark. 
It’s pretty and useful, and it can smell 
wonderful if you want it to. The hidden 
talent of this little bookmark: space inside 
to place a scented cardboard strip. The 
bookmark will perfume the pages of your 
book or you can hang it in your handbag, 
as I do, to catch a whiff of scent each time 
you rummage in your purse for something.

Project by Juliette Lanvers

Visit sewingrepublic.com for more project 
instructions and sewing tips!

http://www.berninausa.com/product_detail-n6-i294-sUS.html
http://www.berninausa.com/webautor-data/798/BERNINA-DivineFlowersVines-OESD1102.pdf
http://sewingrepublic.com/index.html
http://sewingrepublic.com/index.html
http://sewingrepublic.com/projectIdeas.html#/Bookmark/


Piece the Blocks
Select and print foundations for the following:

Note: Any combination of block variations can be 
used as long as they are all the correct size.

•	Two 9" blocks
•	Five 6" blocks
•	Eleven 4 ½" blocks
•	Twenty-two 3" blocks
•	Twenty-one 1 ½" blocks

Using a foundation paper for each block, begin 
piecing in the center and work out in concentric 
squares. For example, start with a red fabric in 
the center, then surround it with four strips of blue 
fabric, then with four strips of yellow. Change colors 
rather dramatically from one round to the next; the 
pieces are tiny and need high contrast to stand out.
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Supplies
•	Scraps to total ¼ yard each of at least 20 

different Kaffe Fassett Woven Stripes

•	¼ yard of a dark Kaffe Fassett Woven Stripe for 
the binding

•	1 yard of any fabric for backing

•	Striped Windows paper foundations (download 
from www.throughtheneedle.com)

•	Rotary cutting supplies

•	Clear ruler, such as a “Cut for the Cure” 4" x 14" 
ruler

•	Piecing thread

by LIZA PRIOR LUCY

Finished size: 30” x 37”

Striped fabrics designed by Kaffe Fassett star in this 
scrappy and colorful quilt. Use paper foundations 
available for download at www.ThroughTheNeedle 
.com and you’ll be amazed at how easy it is to 
make a scrappy quilt that sparkles like sun through 
your windows. The complexity lies in bold color 
combinations and the varying block sizes.

Striped 
Windows

http://www.gloriouscolor.com/
http://www.throughtheneedle.com
http://www.throughtheneedle.com
http://www.throughtheneedle.com
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Complete the Quilt
Remove as much paper as possible from the back of 
the quilt top. 

Place the backing face down on a flat surface, cover 
it with the batting, and then lay the pieced top right 
side up on top. 

Using a neutral, medium-tone thread, machine quilt-
in-the-ditch around the center of each block. Then 
quilt diagonally from the corners of each center 
block to the outer corners of each block.

Trim the edges even, squaring the corners. 

Cut the striped fabric into bias strips and join them 
to make a piece long enough to go around all four 
sides of the quilt. Use your favorite binding method 
to bind the edges of the quilt.

Most of the fabrics should be cut so that the stripes 
run perpendicular to the long edge of each piece; 
they should look like little teeth, not long rails. 
To add interest, occasionally cut the strips so the 
stripes are parallel to the long sides.

As each round is finished, carefully trim the seam 
allowances to about ¼". On the last round, trim to 
exactly ¼" beyond the last printed line.

Assemble the Top
This quilt looks quite difficult, but, in fact, it is 
simple because of how the blocks are sewn one to 
another. There are no set-in seams! Just follow the 
diagram for putting the blocks together, completing 
each of the four sections and then joining the 
sections together. Do not remove the paper until 
each square is sewn in. 

Assemble Section A 
•	One 6" block
•	One 4½" block
•	Four 3" blocks
•	Seven 1½" blocks

Assemble Section B
•	Two 6" blocks
•	Seven 3" blocks
•	Four 1½" blocks

Liza Prior Lucy
Liza lives in New 
Hope, Pennsylvania 
with her husband, two 
daughters, a bulldog, 
and a pug. She can’t 
remember a time when 
she wasn’t stitching 
something. Her first 

patchwork quilt, in 1970, was for her boyfriend’s 
water bed. She sewed bandanas together, backed 
the top with corduroy, and tied it with yarn. The 
quilt she made for her daughter was, fortunately, 
nothing like that! Liza had been introduced to 
Kaffe Fassett when they worked as associates for 
the Rowan Yarn Company, and Liza put to work 
ideas she had learned about color from Kaffe 
into the quilt for her daughter. That first quilt 
was published by Family Circle magazine, and 
Liza continued making quilts, designing patterns 
for Vogue-Butterick publications and BERNINA of 
America, Inc.

In 1993 Liza convinced Kaffe to do a patchwork 
book with her. She interpreted many of his 
knitwear patterns into patchwork, and together 
they worked to create over 30 ideas for the book 
which became Glorious Patchwork, published by 
Ebury/Clarkson Potter in 1997. They continue to 
work together today, designing for the Rowan/
Westminster publications, and are currently 
working on their fifth book together.

Assemble Section C
•	One 9” block
•	Two 6” blocks
•	Four 4½” blocks
•	Five 3” blocks
•	Four 1½” blocks

Assemble Section D
•	One 9” block
•	Six 4½” blocks
•	Six 3” blocks
•	Six 1½” blocks

Stitch Section B to Section C. Stitch Section A to the 
left side of the B/C rectangle. Stitch Section D to the 
lower edge of the A/B/C rectangle.

http://www.gloriouscolor.com/
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Monogrammed Glass

Design a Monogram
After opening the CutWork software, from the New 
Design dialog box, click on the Create New radio 
button and then click Next. 

From the Artwork Source dialog box, click on the 
New Graphic radio button and then click Next.

Select a color from the Fabric dialog box; the lighter 
colors seem to work best. Density isn’t a factor when 
cutting stencils, so the fabric weight doesn’t matter. 
Click Finish.

Click on the Hoop icon. From the drop-
down menu, select the 130mm x 100mm 
Medium #26 hoop. Check the box to 
rotate it 90°. Click OK.

Use your BERNINA CutWork Software 
and Accessory to etch to create etching 
designs for glassware? You bet! Create 
monogram-style letters to personalize 
wine glasses, or try other designs to 
embellish vases and other glassware with 
decorative motifs. In addition to your 
software and cutting tool, you’ll need 
some contact vinyl, a bit of glass etching 
cream, and the instructions that follow.

Supplies
•	CutWork Software and Accessory

•	CutWork compatible embroidery machine

•	CutWork Stitch Plate

•	Medium hoop

•	OESD StabilStick stabilizer

•	Con-Tact® vinyl shelf liner* (non-metallic) 

•	Glass etching cream, such as Armour Etch*

•	Stencil brush*

•	Tweezers (optional, but helpful)

•	Glass items to etch**

* Available at most hardware and home DIY stores

** You’ll find that Con-Tact® vinyl stencils are 
easier to apply on relatively flat surfaces, such 
as rectangular vases or large-diameter vases. 
A narrow champagne flute presents a bit more 
difficulty but it can be accomplished with a little 
patience.

by JOHN THORNTON

BERNINA CutWork 
Monogramming 

— On Glass!

http://www.berninausa.com/product_detail-n6-i294-sUS.html
http://www.berninausa.com/product_detail-n6-i294-sUS.html
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBSST-10
http://www.contactbrand.com/
http://www.armourproducts.com/ecom-catshow/Armour_Etch.html
http://www.contactbrand.com/


Click on the Edit Text icon, then click inside the 
hoop and type a letter. Select View > Toolbars > Tool 
Options and select a font from the dialog box. (The 

available options will depend on which 
fonts are loaded on your computer.) 
Adjust the size as desired. The glass 
shown here used the Sylfaen font at 
52mm.

Click on the Rectangle Selection icon, then click 
on your letter to select it. If the Object Properties 
box isn’t visible, select View > Toolbars > Object 
Properties. Click on the Cutwork icon to change the 
properties from running stitch to cutwork. Make sure 
that no running or other stitches are selected; in this 
project only cutting will be used.

Right click and Copy and then Paste a 
second cutwork letter. Select the copy 
(the pasted letter will be right on top of 
the original) and move it to the right. 

Continue to right click and Paste to fill the top of the 
hoop with letters. For the sample, four letters fit 
right along the top of the hoop.

Click on the first one and then shift + click 
on the last one to select all of the letters. 
To space them evenly, click on the Equal 

Horizontal Spacing icon.

With all of the letters still selected, click 
on the Align Top icon.

Select all the letters on the first row. Copy and Paste 
them, then move the copies below the originals. 
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Enough letters for 
eight glasses in one 
hooping!

Once you have enough letters, navigate to Edit > 
Select All to select all the objects. Right click on the 
letters to bring up the dialog box; select Combine. 
Combining cutwork objects allows you to do all 
the chisel position 1’s together, then all the chisel 
position 2’s, etc. rather than cycling through all 
four chisel positions for each of the eight individual 
letters. 

Save your file as a .Draw file and then 
write the file to your sewing computer by 
clicking the Export icon.

Cut the Stencil
Separate the inner and outer sections of the medium 
hoop. Place the inner hoop on top of the Con-Tact® 
vinyl. Trace the 
inside of the hoop 
and cut the vinyl 
just inside the 
marked line.

Hoop a layer of 
OESD StabilStick, 
backing side 
up. Score the 
perimeter and 
diagonals with a pin or an old needle and remove 
the paper backing. Trim away any excess stabilizer 
outside the hoop. Push the inner hoop just a hair 
further down inside the outer hoop to increase 
tension on the stabilizer. 

Place the Con-Tact® vinyl insert, face up, on top of 
the sticky stabilizer in the hoop and smooth it into 
place.

Bring the Cutwork Accessory file up and attach your 
hooped Con-Tact® vinyl to the embroidery module. 
Begin cutting your stencil, cycling through all four 
chisel positions. If you are cutting out a letter with 
an inside piece, such as a letter “B” or a “D,” don’t 
forget to save those inside pieces from the Con-Tact® 
vinyl as you’ll need them to stick on your glass.

Pull out the chiseled 
stencil pieces; you 
might want to use 
tweezers for this. 

Remove the 
stabilizer and Con-
Tact® vinyl from 
the hoop and trim 
around letters as 
shown. Leave a 
consistent space 
above the letters for 
ease in placing each 
stencil the same 
distance from the 
top of the glass.



Etch the Glass
Peel the Con-Tact® vinyl off its protective backing 
(which should remain stuck to the StabilStick) and 
adhere it to a clean glass, making sure that the Con-
Tact® vinyl is firmly stuck along the etching lines. To 
ensure that the vinyl is firmly in place, rub it down 
with a bamboo or plastic point turner. Or, as an 
alternative, rub the stencil onto the glass through 
some Sew Slip or residual sticky stabilizer backing 
(the part that gets removed and thrown away) sticky 
side down and slick side up. The better the stencil 

is stuck to the glass the 
cleaner the edges of the 
monogram will be.

Apply glass etching 
cream using a stencil 
brush following the 
manufacturer’s instructions. Wash off the cream 
after it has set for the appropriate time, remove the 
stencil, and voilà! A fancy-looking glass with your 
initial or monogram permanently etched on it.

Embellished Glasses

Create Decorative Motif 1
From the New Design dialog box, click on the Create 
New radio button and click Next. From the Artwork 
Source dialog box, click on the From File radio 
button. Click on the Browse button — the square 
button with the ellipses in it. Navigate through the 
files and locate the Bernina CutWork Samples folder 
to access the designs included with the CutWork 
software.

Select design ASC-00075.cmx and 
click Open. Click Next. From the 
Fabric dialog box, select a color 
(any color is fine). Click Next and 
Finish.

Click on the Rectangle Selection tool 
and select the design object. With 
the Object Properties box open, 
click on CutWork to convert the design to cutwork.

Save the design to your 
computer as a .Draw 
file, and then write the 
file to your embroidery 
system using the Export 
icon.

Follow the same 
general instructions 
for cutting the Con-
Tact® vinyl stencil and 
etching the glass as 
for the Monogrammed 
Glass.

Create Decorative Motif 2
From the New Design dialog box, click on the 
Create New radio button and click Next. From the 
Artwork Source dialog box, click on the From File 
radio button. Navigate through the files and locate 
the Bernina CutWork Samples folder to access the 
designs included with the CutWork software.

Select design ASC-00264.cmx and click Open. Click 
Next. From the Fabric dialog box, select a color (any 
color is fine). Click Next and Finish.

Click on the Rectangle Selection tool; select and 
delete the objects inside the hibiscus so that only 
the flower’s outline remains. Select the remaining 
hibiscus outline and, with the Object Properties 
box open, click on Cutwork to convert the flower to 
cutwork.

Copy and Paste the object for a total of three 
flowers, changing their size and 
rotation to make them look more 
random. Click on Edit > Select All; 
right click on the three cutwork 
objects and select Combine from the 
list. The three layers shown in the 
Sequence Manager will collapse into a 
single layer.

Save the design to your computer as a .Draw file, 
and then write the file to your embroidery system 
using the Export icon.

Follow the same 
general instructions 
for cutting the Con-
Tact® vinyl stencil and 
etching the glass as 
for the Monogrammed 
Glass.
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John Thornton, a financial economist by day, is a 
DesignerPlus, EditorPlus, and CutWork Accessory 
software educator at Sew From The Heart in 
Scottsdale, AZ. He naïvely walked into the local 
BERNINA dealership one day with a simple need to 
repair the seat covers in his BMW. He walked out 
with an aurora 240. A month later he purchased 
an artista 730 after becoming obsessed with 
embroidery. He now sews and embroiders on a 
new BERNINA 830. He also teaches Sewing for 
Dogs and Sewing for Men classes and he created 
and implemented a Software Fair to encourage 
customers to test-drive 
BERNINA DesignerPlus 
Embroidery Software 
and learn how easy 
designing one’s own 
embroidery projects 
can be. John designs 
embroidery motif logos 
for businesses and 
non-profits, but he 
prefers more unique 
design commissions 
such as tattoos and generally encourages more 
comedy and dark humor in embroidery motifs. 
His offbeat approach to embroidery leads him to 
unusual projects such using the BERNINA Cutwork 
Accessory to etch glass.
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Recycle the Discards
You might want to keep the discards from your 
stencils, or use the Cutwork Accessory specifically 
to create decorative stickers. Con-Tact® vinyl 
comes in a number of decorative finishes, such 
as metallics. These discards from the hibiscus 
project serve as decorative warnings on a large 
floor-to-ceiling picture window.

http://www.rickytims.com/seminars


The trick to digitizing lace is to have layers of 
stitches run at right angles to each other. The 
crossing of the vertical and horizontal stitches is 
what creates the interlocked lace fabric. I started 
this freestanding lace design by creating a petal 
shape using the Free Hand Embroidery Closed Object 
tool. I wanted a non-symmetrical, loose design so I 
drew it quickly. I smoothed and simplified the shape 
using the Reshape Object tool, then filled it with 
a widely-spaced fill stitch running horizontally. I 
selected and duplicated the petal and changed the 
angle of the fill stitches to run vertically. Finally, I 
selected both petals and grouped them together. 
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Supplies
•	Jeanine’s Lace Flower embroidery design 

(download from www.ThroughTheNeedle.com)
•	OESD AquaMesh stabilizer
•	Threads for embroidery*
•	A decorative button or beads for flower center
•	Coordinating upholstery or other strong thread
•	Embroidery needle
•	Alligator clip or other jewelry finding 
•	Small embroidery hoop

*In these examples I used Isacord polyester or 
Sulky cotton embroidery threads in the needle. 
In the bobbin I used rayon, metallic threads or 
a lightweight needle-punch wool/acrylic yarn. 
The lightweight yarn (pink flower) creates a thick 
fabric. Whatever you use in the bobbin must 
be thin and smooth enough to pass through the 
bobbin easily. Always stitch SLOWLY when you use 
specialty threads and yarns.

For the flower center, just use your imagination! 
Get out that button and bead box and have fun! 
This is the perfect place to use a vintage pin, add 
lace or tulle or Grandma’s earring, or to practice 
some beadwork. Be creative and have fun!

by JEANINE McWHORTER

Jeanine’s  
Lace Flower 

BERNINA Embroidery Software 6 has so many 
powerful features! You can create your own 
free-standing lace designs or just jump in and 
stitch beautiful flowers like these in a snap.

http://www.etsy.com/shop/jeaninedesigns
http://www.throughtheneedle.com
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBWAM-15
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Create the Petals
Download Jeanine’s Lace Flower file from www.
ThroughTheNeedle.com and open it in your 
embroidery system.

Hoop a layer of AquaMesh. Set up the embroidery 
system with an Embroidery needle, bobbin thread, 

and needle thread in the 
first color for the design. 
Since both the bobbin 
thread and the needle 
thread will be visible, give 
thought to what you use. 
I like to experiment with 
specialty bobbin threads for 
interesting effects.

Stitch the outline (Color 
1). For a thicker edge, 

use a heavy thread in the bobbin for this step. The 
outline will stitch first and will be covered by the 
other stitches. You can use a heavier thread in the 
bobbin if you want a thicker edge. For this flower I 
used variegated pink cotton in the needle and thin 
salmon-pink yarn in 
the bobbin for the 
outline and also for 
both layers of lace 
stitches.

Stitch the lace layers; 
these stitches have a 
slight zigzag and, once 
combined, create a 
nice texture in the 
finished flower. The first layer stitches vertically. If 
you are using a heavy weight yarn, as I have here, 
the underside will not be pretty at this point. Don’t 
panic — it will be fine.

TIP: I don’t usually bother cutting threads with 
this design. I’m just careful to make sure the foot 
doesn’t catch on any long jump stitches. Any random 
stitches or threads blend in and I think add to the 
texture. 

It is easy to move items around in BERNINA 
Embroidery Software 6, so I do most of my 
design work right on the desktop. Selecting 

the grouped petal design, I copied it several times 
and stretched, flipped, and turned the petals, 
creating a group of similar yet different petals. I 
chose three of my favorites and arranged them by 
overlapping the center points slightly so the stitches 
would overlap. 

The Outline Design tool can do lots of things 
and comes in handy when creating lace. 
Using the Polygon Select tool I selected the 

three-petal arrangement, clicked on the Group icon, 
and then chose the Outline Design option and set it 
to -0.1. This created an outline of the entire shape 
that would stitch just slightly inside the other layers 
and stabilize the edges. With this line selected, I 
opened Color Bar and dragged the outline to the top 
so it would stitch first. 

I finished my lace petals with two layers 
of hand-drawn shading effects using the 
Free-Hand Embroidery Open Object Tool 

and selecting varying colors to enhance the three-
dimensional design. These layers aren’t absolutely 
necessary for structural integrity. If you create your 
own free-standing lace petals you can omit them, 
especially if you lay a sheer fabric on top of the 
stabilizer before stitching the first color, then trim 
away the excess after the initial outline stitch is 
sewn. This is the 
technique I used to 
create the elegant 
white flower, which 
stitches out super-
fast since there are 
no color changes. 
A cascade of these 
white flowers 
around a neckline 
or bridal veil would 
be stunning.

I hope this inspires you to digitize and/or stitch your 
own bouquet of lace flowers. To get you started, I’m 
delighted to share my original design with you, which 
you can download free at www.throughtheneedle.
com. And I’d love to see any resulting creations. 
Please send photos of your flower creations to  
jo@berninausa.com!

http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.throughtheneedle.com


TIP: Fun two-toned effects can be created by using 
one color in the bobbin and a different color in 
the needle. You can also stitch the horizontal and 
vertical layers in different colors. Experiment with 
colors or make a one-color flower in a snap, like the 
very chic white wedding flower.

Stitch the shading veins. There are two sets of 
“veins” in this design; one spans the entire flower, 
and the other a smaller area near the flower center. 
Stitch one or both to add light or dark shading to 
your flower. I programmed the design so the bottom 
petal set is one color and the top another. However, 
since BERNINA embroidery systems make it easy to 
move from stitch to stitch, you can customize the 
colors as you go along. On this flower I used just two 
threads: variegated orange for the large set of veins, 
and variegated yellow for the small set.

I can never wait — right after a soak in hot soapy 
water and a 
rinse, I iron the 
petals dry to 
see how they’ve 
come out. In 
doing so, I found 
that the iron 
flattens and 
burnishes some 
metallic threads 
and makes them appear shinier — a nice effect. 

While the petals are damp you can add dimension 
by pushing and pulling with your fingers, or you 
may iron them completely flat. There will be lots 
of threads to trim but don’t worry — nothing will 
unravel. Sometimes I use a lighter to clean up the 
edges by carefully burning off tiny fibers.
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Assemble the Flower
Lay the smaller 3-petal group on top of the larger 
3-petal group, aligning the largest petal on the top 
group with the largest space between petals on the 
bottom set. You can machine-stitch these together, 
but I usually hand-stitch with upholstery thread and 
add the flower center and finishing hardware at the 
same time.

Attach the small 
single petals as you 
wish, depending on 
what you choose 
for the center. 
Here I attached 
them to the shank 
of a vintage 
button to give 
more dimension to 
the finished flower.

I finished this flower by 
stitching on an inexpensive 
alligator clip purchased at 
a bridal supply store. I like 
these clips because they are 
strong and the flower can be 
worn in the hair, on 
a scarf or blouse, 
or used as a unique 
gift topper. Other 
options include 
stitching it to a 
barrette, headband, 
wristlet, or brooch.

Jeanine McWhorter is a fiber artist 
who has lived her adult life in 
Southern California. “But I was 
raised in Georgia, so that makes me 
Double-Southern.” She attended the 
Atlanta College of Art and has taught 
machine embroidery. A former arts 

marketer, fundraiser, gallery owner, and part-time artist, 
she now spends all her time in her studio with cameras, 
computers, sewing machines and every supply, fiber, 
fabric, bead and trim known to mankind. It’s her goal to 
use these all up in her creations before she dies. 

Her embroidered art work has been selected for 
exhibitions such as “Designed to Wear,” seen in print 
media such as GenLux Magazine, and is in private 
collections internationally, including that of actress 
Jennifer Love Hewitt. To see more of Jeanine’s work or to 
contact her, visit www.jeaninedesigns.etsy.com. 

http://www.etsy.com/shop/jeaninedesigns
http://www.etsy.com/shop/jeaninedesigns


Supplies
•	OESD’s Divine Flowers & Vines 	
Premier Collection #1102

•	Dupioni Silk: 1 yard each of 2 	
complimentary colors 

•	OESD Fusible PolyMesh stabilizer
•	OESD PolyMesh stabilizer
•	505 Temporary Spray Adhesive
•	Isacord embroidery thread
•	Embroidery bobbin thread
•	Sewing thread
•	Flexible sewing tape measure
•	Nifty Notions “Cut for the Cure” 7" x 24" ruler
•	Nifty Notions “Cut for the Cure” 11" Square ruler
•	Water-erasable fabric marking pen
•	Embroidery scissors
•	Crafting knife
•	Ready-to-upholster ottoman 
•	Staple gun (for upholstery)
•	Screwdriver (for upholstery)
•	Embroidery system
•	Your largest embroidery hoop and template
•	Edgestitch foot (BERNINA Edgestitch Foot #10/10C/10D)
•	¼" foot (BERNINA Patchwork Foot #37/37D or #57/57D) 
•	Embroidery software (optional)
•	Serger (optional)

Displaying beautiful artwork is not limited 
to hanging pieces on walls. Any item with a 
flat surface becomes a canvas for showing off 
beautiful embroidery designs. The Divine Flowers 
& Vine Premier Collection — a BERNINA exclusive 
— offers elegant dimensional designs that can be 
used to stitch breathtaking artwork for any room.

The ottoman featured in this project is a 16" 
square ready-to-upholster ottoman from DIY 
Upholstery Supply. This project is also a perfect 
way to give new life to an old ottoman — check 
your attic and local thrift shops for a unique find.

Divine 
Flowers 
& Vines 
Ottoman

by DEBRA RUTLEDGE
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http://www.berninausa.com/webautor-data/798/BERNINA-DivineFlowersVines-OESD1102.pdf
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBF15-10
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBC15-15
http://www.embroideryonline.com/products/ItemDetail.aspx?ItemCodeID=321
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.brewersewing.com/bqss_consumer/productmain.asp?STRING=cut+for+the+cure&category=
http://www.berninausa.com/product_detail-n25-i140-sUS.html
http://www.berninausa.com/product_detail-n25-i343-sUS.html
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.berninausa.com/product_overview-n5-sUS.html
http://www.berninausa.com/webautor-data/798/BERNINA-DivineFlowersVines-OESD1102.pdf


Prepare the Cover Fabric
To determine the finished size of the cover, measure 
the top of the ottoman — from the staples holding 
the cover on one side, around the top, to the staples 
holding the other side of the cover. Add 1" along 
each side. For this 26" x 26" ottoman a 28" x 28" 
square of fabric was cut for the embroidered cover.

For this ottoman a 16" x 16" finished square was 
desired for the embroidered cover; an 8" x 8" center 
surrounded by two 2"-wide borders. Your ottoman 
may be a different size; determine the sizes of the 
center and border pieces based on your ottoman’s 
measurements.

For our ottoman we cut the following pieces:

Center: One 8½" x 8½" blue square (A)

Border 1: Two 2½" x 8½" brown strips (B) 	
	 and two 2½" x 12½" brown strips (C)

Border 2: Two 2½" x 12½" blue strips (D) 	
	 and two 2½" x 16½" blue strips (E)

To prepare the fabric to be embroidered, use a ¼" 
foot to sew the ottoman top pieces together. Sew 
the shorter brown strips to opposite sides of the blue 
square and press the seam allowances away from 
the center. Add the remaining brown strips, press, 
and then add the blue strips in the same manner. If 
the fabric ravels easily, finish the outer edges of the 
pieced panel with an overlock stitch using a serger 
or sewing machine.

Attach an edgestitch foot to the sewing machine.
Align the guide in the seam ditch between the 
center block and the first border. Move the needle 

position to 2-3 steps away 
from the center of the pieced 
square; topstitch along the 
inner edge of the first border. 
Repeat for the second border.

Follow the manufacturer’s 
instructions to fuse OESD 
Fusible PolyMesh to the wrong 

side of the pieced cover and add stability to the silk 
dupioni.
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Embroider the Pieced Fabric
Select the designs for the ottoman cover and print 
out placement templates for each one. Shown on the 
sample are designs BE110203, 04, 05, 08, 09, 13, 14 
and 16 from OESD’s Divine Flowers & Vines Premier 
Collection #1102.

Position the designs on 
the cover as desired. 
If embroidery software 
is available, use it to 
plan the placement 
of the designs on the 
ottoman and print a 
template for the entire 
design combination.

Using a water-erasable 
fabric marker, mark 
the center position of the first design to be stitched.

Hoop two layers of OESD PolyMesh stabilizer. Spray 
the hooped stabilizer with 505 Adhesive Spray. 
Hand press the wrong side of the ottoman cover 
onto the hooped 
stabilizer, aligning 
the marked 
center of the 
first design with 
the center of the 
hoop template. 
Embroider the first 
design.

When the design is complete, remove the hoop 
from the machine and the fabric from the hoop. 
Trim away the excess stabilizer from around the 
embroidered design.

Repeat until all of the selected designs have been 
embroidered.



Some of the flowers and leaves in this collection 
are stitched with multiple layers of satin stitching. 
Following the instructions included with the 
collection, carefully slice these threads using a 
crafting knife; the resulting “velvet” tufts add 
dimension to the design.

Construct the Ottoman Cover
Measure the sides of your 
ottoman and cut rectangles to 
cover them. For the sample 
ottoman two 6½" x 16½" and 
two 6½" x 28½" rectangles 
were cut. Stitch the side 
pieces to the embroidered 
cover as shown, pressing the 
seams away from the center. 

If the fabric ravels easily, finish the outer edges with 
an overlock stitch using a serger or sewing machine. 
Fold under a ¼" hem around all four sides of the 
ottoman cover. Attach the edgestitch foot to the 
machine, align the guide with the raw edge of the 
hem, and move the needle position 2-3 steps toward 
the hem. Stitch the hem in place.

Cover the Ottoman Base
Place the embroidered cover right side down on a 
clean, flat surface. Center the ottoman base, top 
side down, over the cover.

If necessary, mark the positions for the ottoman legs 
and drill pilot holes before attaching the cover. 

Using 2" flathead pins, pin the cover snugly to the 
base at each corner. It is not necessary to stretch 
the cover tightly at this point; the cover will be 
stretched throughout the rest of pinning process.

Turn the base over to ensure the cover is centered; 
make any necessary adjustments to the position of 
the cover.

Turn the base top side up again, and pin the cover in 
place at the center of each side. Continue pinning 
each side, stretching and pinning until the cover 
is taut. Using a 
staple gun, staple 
the edges of the 
cover to the base. 
Attach the legs 
to the base to 
complete your 
ottoman.

TIP: Make a template of the base of the legs, 
with holes punched at the pilot hole locations. 
Position the template at each cover of the 
base, then mark the drilling locations with a 
pencil.
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I started with a 
patriotic color theme 
in mind. Once I 
focused on looking 
only for red, white, 
and blue it was plenty 
easy and tons of fun 
to find garments that 
worked together. 

To recreate this look, set your serger for a wide 
3-thread overlock stitch with YLI Woolly Nylon in the 
upper and lower loopers. Variegated Woolly Nylon 
was used in the upper looper for our little jumper. 
Place the fabrics wrong sides together and serge; 
the serged seam allowances form decorative frills 
between the patches.

Using an existing garment as a guide — or a 
purchased paper pattern — cut the bodice front from 
your patchwork piece.
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by NANCY BEDNAR

Don’t sell those t-shirts at a yard sale — upcycle 
them into cute clothes for your little ones!

It’s easy to recycle t-shirts using your serger! Collect 
a pile of shirts — Dad’s old golf shirt, Mom’s summer 
top, little sister’s outgrown discards — then cut 
them into pieces and serge them together to create 
one-of-a-kind outfits. The exposed serger stitching 
ties all of the elements together while creating an 
additional fashion accent.

Patriot’s Love Jumper
The spark for this patriotic outfit was a favorite — 
but too short — red polka-dot knit sundress that 
also had a big stain on the skirt. First, I cut the top 
off just below the waist and set it aside for later 
embellishment. To create a base for the jumper 
skirt, a few inches were cut from the center of the 
dress, carefully avoiding the stained places. 

Novelty t-shirts 
provide a treasure 
trove of fun designs; 
for the front of the 
jumper bodice, a 
square was fussy-cut 
from the front of a 
t-shirt. Scraps of the 
red knit (piece as 
needed) were serged 
to the sides, then strips of coordinating knits from a 
t-shirt were added to the upper and lower edges. 

Upcycled
Clothes
for Tots

http://nancybednar.com/
http://www.berninausa.com/product_overview-n5-sUS.html
http://www.ylicorp.com


Nancy Bednar is a sewing educator, freelance 
instructor and author. A passionate sewer since 
elementary school, she has explored and enjoyed 
many creative and practical aspects of sewing. 
She regularly trains both BERNINA dealers and 
consumers alike on fine garment sewing and 
creative machine techniques using both the 
sewing machine and serger. 

Nancy's published books include the most recent, 
Creative Serging: Innovative Applications to 
Get the Most from Your Serger, as well as The 
Encyclopedia of Sewing Machine Techniques 
and Silk Ribbon Machine Embroidery. Nancy is 
enjoying discovering Southern hospitality first 
hand, recently moving from her home in Illinois 
to a new address in Alabama. There she is 
happily creating with her Southern gent, canine 
assistants, multiple sewing machines and more 
yards of fabric and thread than she can count.

www.nancybednar.com

The remaining red fabric — along with fabrics from 
coordinating t-shirts — was cut into squares and 
serged together to make fun patchwork fabric for 
the bodice back. Serge together several squares to 
make a piece large enough to accommodate the 
bodice back, then trace the pattern piece and cut 
the fabric. 

To make the red knit “skirt,” I cut along both sides 
of one side seam to create a flat strip of fabric 
(mine was about 40" long). Next I serged assorted 
knit squares together (4" to 5" wide) to create a 
continuous patchwork strip the same length as the 
red for the upper skirt. I placed the layers right sides 
together and used a 4-thread overlock stitch to seam 
them together. Then I finished the hem using the 
same 3-thread overlock and variegated thread as for 
the patchwork.

For the jumper straps, I cut 2"-side strips from the 
red-and-white polka dot dress, then folded them in 
half lengthwise with raw edges aligned and serged 
them together. The variegated thread created a 
wonderful decorative effect along the finished edge.

To construct the jumper, I set my 
serger for a 4-thread overlock 
stitch. After serging together 
the bodice and skirt, the upper 
edges of the bodice were simply 
turned under and fused in place 
using Steam-a-Seam 2. The 
underarms were turned under and 
zigzagged on my sewing machine. 
I also attached the straps at the 
sewing machine, placing the ends 
underneath the upper corners of 
the front and back, then straight-stitched rectangles 
along the all four edges to attach them.

Done! Now on to make a coordinating top.

I S S U E  6  •  1 7

Cha-Cha Top
The bodice cut from the red-and-white polka dot 
sundress was already embellished with appliquéd 
stars and a tiny red bow. All that was necessary was 
to finish the lower edge with a little flirty ruffle. 
For that, I cut a 1½"-wide strip of knit fabric from 
a t-shirt, finished one edge with a rolled hem, and 
then gathered it to fit the lower edge of the top. It 
was stitched to the 
top with a 4-thread 
overlock stitch. 

Use your imagination 
and simple patterns 
to create a whole 
wardrobe of 
“t-shirt” garments — 
including, perhaps, 
leggings and shorts 
for the wee ones. You can even use adult knit 
leggings and cast-offs for some of your “fabric.” 

For a fun afternoon, invite your friends to a 
t-shirt sharing and stitching party! Guests 
bring an assortment of laundered t-shirts to 
cut and share, and go home with cute new 
garments for their little ones.

http://nancybednar.com/
http://nancybednar.com/
http://www.warmcompany.com/lsaspage.html
http://www.berninausa.com/product_overview-n5-sUS.html
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The Snap Happy Purse Pattern by 
Stitchin’ Sisters is the perfect pattern 
for creating useful pouches to keep 
sewing notions, iPod chargers, phone 
accessories, and the like. Create the 
size you need and the style you desire 
by incorporating these fun sewing 
techniques.

Supplies
•	“Snap Happy Purse Pattern” by Stitchin’ Sisters

•	Fabric and notions as required by the pattern 
instructions

Additional Supplies for Stitch Recipe Technique
•	Chalk marker

•	Clear ruler or straight edge

•	Isacord embroidery thread

•	OESD Ultra Clean & Tear Stabilizer 

•	505 Temporary Adhesive Spray

•	BERNINA Clear Embroidery Foot #39C

•	BERNINA Clear Reverse Pattern Foot #1C/1D

•	BERNINA Adjustable Seam Guide 

Additional Supplies for Channel Quilting Technique
•	Chalk marker

•	Clear ruler or straight edge

•	Isacord embroidery thread

•	Non-Stick Zigzag Foot #52D

•	BERNINA Adjustable Seam Guide 

Additional Supplies for Bobbin Play Technique
•	Heavy decorative thread or silk ribbon

•	Isacord embroidery thread to match

•	OESD AquaMesh Water-Soluble Stabilizer 

•	505 Temporary Adhesive Spray

•	Extra sewing bobbin case (if not using an 8 Series 
machine)

•	BERNINA Stitch Regulator #42

Snap 
Happy 
Pouches

by PAULA HARMON

http://stitchinsis.com/catalog/
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBT17-15
http://www.embroideryonline.com/products/ItemDetail.aspx?ItemCodeID=321
http://www.berninausa.com/product_detail-n25-i148-sUS.html
http://www.berninausa.com/product_detail-n25-i290-sUS.html
http://www.berninausa.com/product_detail-n25-i289-sUS.html
http://www.berninausa.com/product_detail-n25-i289-sUS.html
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBWAM-15
http://www.embroideryonline.com/products/ItemDetail.aspx?ItemCodeID=321
http://stitchinsis.com/


Open Combi Mode and program the following:

•	Stitch #431
•	Stitch #431 + Mirror Image Up/Down
•	Stitch #448
•	Stitch #447 + Mirror Image Up/Down
•	Save

Stitch with the left side of the presser foot riding 
along the edge of the first line of stitching. 

Press the Pattern Begin icon to ensure that the next 
line of stitching will start at the beginning of the 
stitch sequence. Engage Mirror Image Left/Right, 
and then stitch the combination on the other side of 
the first line of stitching, with the right side of the 
presser foot riding along the edge of the first line of 
stitching.

Exit Combi Mode. Select Stitch #461 and sew a line 
at each side of the combination. 

Variation I — Stitch Recipe
While decorative stitches are lovely in their own 
right, when combined with other stitches their 
beauty increases exponentially, and the creative 
potential is unlimited! Stacking combinations of 
decorative stitches side-by-side—creating a “stitch 
recipe”—is an easy way to create embellishments 
which mimic elegant machine-embroidered borders. 

Lightly spray a layer of OESD Ultra 
Clean & Tear Stabilizer with 505 
Temporary Adhesive Spray and 
adhere it to the back of the fabric. 
(Alternatively, fuse a layer of OESD 
Fusible Tear-Away Stabilizer to the 
fabric.)

Mark a chalk line down the center 
of the fabric. Mark a perpendicular 
line at one end to mark the starting 
line for each row of stitching. At the 
beginning of each line of stitching, 
align the red marks at the left and 
right sides of Clear Embroidery Foot 
#39C with the marked starting line. 

This foot is preferred for compact satin stitches; 
for open stitch patterns, Reverse Pattern Foot with 
Clear Sole #34C/D may be used.

Tip: Use Clear Embroidery Foot #39C when sewing 
stitch recipes. The carved-out area of the sole 
allows compact stitches to easily move under the 
foot, while the clear sole and red markings make it 
easy to see the needle and keep the fabric perfectly 
aligned while stitching.

Sew a row of stitch #470, aligning the center guide 
of the foot with the marked line. Engage the Pattern 
End function to ensure that a whole stitch, rather 
than a partial one, is stitched at the end of the line.

When all stitching is complete, gently pull away the 
excess stabilizer. 
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Variation II — Channel Quilting on Vinyl
Create a designer-style pouch by grid-quilting vinyl, 
faux leather, or suede fabrics.

Attach Non-Stick Zigzag 
Foot #52D to the machine 
and engage the BERNINA 
Dual Feed. This will 
ensure that the vinyl 
feeds smoothly and evenly 
under the presser foot. 

Attach the Adjustable 
Seam Guide to the back of 
the foot and set the guide 
1” from the center needle 
position. Use the guide to keep the lines of stitching 
evenly spaced.

Mark two perpendicular 45° chalk lines on the fabric.

Select Stitch #713, the hand-look cable/smocking 
stitch. Sew along each of the marked lines, guiding 
them under the center of the presser foot.

Stitch lines parallel 
to the first lines, 
aligning the edge of the 
Adjustable Seam Guide 
with the previously 
stitched rows.

Variation III — Bobbin Play
Bobbin play is used with threads that are too thick 
to be used in the needle 
of the machine. The 
stitching is actually 
“upside-down,” with 
the bobbin thread 
embellishing what will be 
the “top” of the fabric. 

Wind a bobbin with your chosen thread. Threads 
that work well for bobbin work include YLI Silk 
Ribbon, YLI Candlelight (shown in the sample), YLI 
Pearl Crown Rayon, and Razzle Dazzle by Superior 
Threads.

To enable cord or ribbon to flow easily from the 
bobbin area, a loose bobbin tension is required. 

On an 8 Series machine, use the multifunction tool 
to adjust the post to the left about 2-3 clicks for 
heavy threads.

For silk ribbon, do 
not adjust the post; 
instead, thread the 
ribbon through the 
hole in the bobbin 
basket as shown in 
the photos.

Note: For other 
machines, 
purchase a second 
sewing bobbin 
case and adjust 
it for bobbin 
play techniques, 
leaving the 
original bobbin 
case settings in 
place. 
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Thread the needle with Isacord embroidery thread 
in a matching color.

Attach the large clear sole to the BERNINA Stitch 
Regulator, and then install the BERNINA Stitch 
Regulator on the machine.  

Spray the back of a sheet of OESD AquaMesh Water-
Soluble Stabilizer with 505 Temporary Adhesive Spray 
and adhere it to the wrong side of the fabric. Draw a 
continuous line motif on the AquaMesh with a water-
soluble pen and – Voila! – you have an easy-to-follow 
stitching line. 

Place the fabric right side down on the bed of the 
machine. Select a starting point; move the needle 
down into the fabric and back up to bring the bobbin 
thread to the surface. Move the thread tails to the 
back of the foot. 

Free-motion stitch along the marked line. When 
stitching is complete, rinse away the excess 
stabilizer.

TIP: Clear Reverse Pattern Foot #34D is an excellent 
choice for stitching the side seams.

The BERNINA Stitch Regulator has three 
interchangeable soles:

•	A closed metal sole, similar to a darning foot

•	An open metal sole, similar to a freehand 
embroidery foot

•	A large transparent sole, similar to a freehand 
quilting foot

It also has two stitching modes:
•	Mode 1 — the needle stitches continuously; 
when the fabric is at rest the needle moves up 
and down very slowly

•	Mode 2 — the needle 
stitches only when 
the fabric is in 
motion; when the 
fabric is at rest the 
needle comes to a 
complete stop

Construction
After creating your embellished fabric, follow the 
Snap Happy pattern construction directions to 
construct your pouch. A metal tape measure is the 
“magic” behind the spring of the closure, and you’ll 
be able to make several pouches from one tape 
measure. 

TIP: For zigzagging the raw edges, align the guide of 
Edgestitch Foot #10D with the raw edge and move 
the needle position to the far left.

I S S U E  6  •  2 1



2 2  •  T H R O U G H  T H E  N E E D L E  O N L I N E

The Last Word

Quick Links
These are the main links featured in 
this issue; see the articles for links to 
specific products, projects, and technique 
information. Please visit our sponsors 
and contributors for more inspiration, 
information, and stitching fun!

•	http://www.throughtheneedle.com 
•	http://www.berninaUSA.com 
•	http://www.benartex.com
•	http://www.berninausablog.com
•	http://www.embroideryonline.com 
•	http://www.bernina8series.com/EN/ 
•	http://www.berninamylabel.com 
•	http://www.gloriouscolor.com/
•	http://www.etsy.com/shop/JeanineDesigns 
•	http://nancybednar.com/ 
•	http://www.rickytims.com/seminars

A sneak peek at what’s coming in  
Through the Needle ONLINE, Issue #7:

Up-Cycled Purse Redux
Sharon Waligora, a reader from Canton, MI, sent us a 
photo of this “Tweedy Purse” she made for a local sewing 
guild purse challenge. In the next TTNO she shares tips for 
creating your own purse from men’s tweed jackets rescued 
from a thrift store. This purse pattern was previously 
featured in TTNO Issue #1, “Susan’s Designer Handbag.” 

Baby’s Got Back!
Learn four reasons why you might want to piece your quilt 
back – including “It’s just fun!” Gyleen Fitzgerald shows how to easily 
calculate the size and number of blocks and sashing strips needed to 
create quilt backs that are just as pretty as the fronts! 

July 2011 Special
Free-motion FREEDOM!
Use the BERNINA Free-motion 
Couching Foot to add cords, ribbon 
and braid to your convertible clutch 
project (featured in the If the Shoe 
Fits, Make a Purse series).
For July 2011 only, purchase 
the BERNINA #43 Free-motion 
Couching Foot, and receive the 
Convertible Clutch pattern FREE.
Offer good July 2011 at participating BERNINA 
dealers in the USA and Canada. Coupon may 
not be combined with any other offer.

Until August ... 
As always, we hope this issue of Through 
the Needle ONLINE has inspired you to learn 
something new and make your own adaptations 
of our projects. We love seeing your creations; 
send e-mail and photos to jo@berninausa.com.

Ruffles made easy!
Create yards of gathered and 
pleated fabric for garments and 
home decorating projects in just 
minutes!
For June 2011 only, get 20% OFF 
the #86 Ruffler Attachment.
Offer good June 2011 at participating BERNINA 
Dealers in the US and Canada. Coupon may not 
be combined with any other offer.

June 2011 Special

#86 Ruffler 
Attachment

20% OFF

FREE Pattern 
Convertible Clutch

with purchase of  
#43 Couching Foot

http://www.throughtheneedle.com
http://www.berninausa.com/content-n911-sUS.html
http://www.berninausa.com/dealer_search2-n99-sUS.html
http://www.berninausa.com/dealer_search2-n99-sUS.html
http://www.colourfulstitches.com/
http://www.berninausa.com/product_detail-n25-i59-sUS.html
http://www.berninausa.com/product_detail-n25-i149-sUS.html
http://www.berninausa.com/product_detail-n25-i149-sUS.html
http://www.berninausa.com/product_detail-n25-i59-sUS.html
http://www.throughtheneedle.com
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